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Exercise 3.1
Create a simple report using InfoAssist
Open InfoAssist by right clicking on your folder in the INFO ASSIST Class folder and selecting InfoAssist.

Select Build a Report from the Splash Screen.

In the Open dialog select SPRIDEN_CURRENT_ASU_V and click OK.
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Double click spriden_id in the data window, notice that it is displayed in the interactive design view window. Continue selecting the following
fields—spriden_last_name, spriden_first_name, spriden_mi, and spriden_change_ind.
Your report should look similar to the picture below.
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Now we are going to add some selection criteria to our report.

Click and hold spriden_change_ind field in the data window and drag to the filter window.

In the Filter for spriden_change_ind windows click on the down arrow and select missing.

Anytime we use spriden for a report we want to set this filter.

Click OK.

Notice the change in your interactive design view. Click on the SLICERS tab and Select 500 for Run time. Run your report.
Click on the IA button and select Save as

Name your report yourname31 (example linda31) and click OK

Click on the |IA Button again and select exit. You should be back to your folder and see your new report under it.
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Exercise 3.2

Sorting, adding page headings and footings and changing a column heading

In your folder under INFO ASSIST Class folder. Right click on yourname31 and select Open.
Once the report is open in InfoAssist click on the IA button and select Save As . Name the report yourname32. Click OK.
Notice the way our report is sorted. It is sorted by spriden_id. We would really like it sorted by last name, first name, middle initial.

In the query panel select spriden_last_name by clicking on it and move it up to the first position under the by, select spriden_first_name and
move it under spriden_last_name, select spriden_mi and move it under spriden_first_name.

Notice how your report changes in the Interactive Design View window.
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We really do not want our report to look this way. We want it sorted by spriden_last_name but we would like to see the fields in the following

order spriden_id, spriden_last_name, spriden_first_name, Spriden_mi

How can we accomplish this?

In your Interactive Design View window select Spriden_last_name and right click, scroll down to Visibility and select Hide.

Do the same with spriden_first_name and spriden_mi.
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Your report should look like the picture on the left below. We want to see Spriden_last_name, spriden_first_name and spriden_mi in our report.

Click and drag spriden_last_name, spriden_first_name and spriden_mi into the interactive design view window place them after the spriden _id in the
report. The picture on the right below is how your report should look now.

Highlight Spriden_change_ind in the interactive Design View window, right click and select delete. This will remove spriden_change_ind from your
Report.

Next we will change our column heading names.
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Select spriden_id in the Interactive Design view window right click and select Change Title. Enter ID in the Enter Title box and click OK.

Continue to change the field titles in the report. Select Spriden_Last_name and change the title to LAST NAME. Select Spriden_first_name and
change the title to FIRST NAME. Select Spriden_mi and change the title to MIDDLE NAME.

Click on the Slicers tab and select 500 in the Run Time box. Run the report.
Once you finish with this click on the IA button and Select Save.

Now we are going to add a header and footer to our report.
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Make sure the HOME tab is the active tab in InfoAssist. Click the Header & Footer button, If you do not see the Header & Footer button, Click the
Report button then click Header & Footer Button. Select Page Header and type SIMPLE PERSON LIST in the window. Notice you can format the
heading right in this same window. Play with it. Once you like your heading click OK.

If you end up with a report heading and a page heading select the report heading and right click and select delete. It will remove the report head-
ing and leave your page heading.

Now we will add a Page Footing
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Click the small down arrow next to the Header & Footer button on the home tool bar and select Page Footer. Type in Prepared on:
Click the preformatted text button and Select Date then the date with the day name, month, day, and year.
Click Apply then Okay. Scroll to the bottom of your Interactive Design View window and check your page footing. Run your report.

Click on the IA button and select save. Click on the IA button again and select exit. You should return to your folder under the INFO ASSIST Class
folder.
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Exercise 3.3
Using Sort, Sum and Across to create a Matrix Report

Create a new report using SHRTRCE. Right click on your folder and select InfoAssist. At the InfoAssist Splash Screen select Build a Report. Select
SHRTRCE from the Open dialog window and click OK.

Add the following fields to the report—shrtrce_term_code_eff and shrtrce_credit_hours. Notice the report is sorted by shrtrce_term_code_eff

and shrtrce_credit_hours are summed.
Now add shrtrce_pidm to the report. Place it at the beginning of the report in front of shrtrce_term_code_eff.

Go to the query pane and drag shrtrce_term_code_eff under across. You have just created your first matrix report. Click on the Slicers Tab and

Select 500 in the Run time box. Run the Report.

Click on the IA button and select Save. Name your report yourname33 click ok. Click on the IA button again and select Exit.
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Exercise 4.1

Create Filters in a Report

Create a new report using SARADAP. Add saradap_pidm, saradap_term_code_entry, saradap_styp_code, saradap_admt_code to the report.

Grab saradap_term_code_entry and drag to the filter area. The Filter for saradap_term_code_entry dialog window opens. In the Add dialog box
type 201110 then click the add button. Notice the selection values windows is now populated with 201110. Click OK.

Notice your Interactive Design View window changes to just the saradap_term_code_entry of 201110.
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Add the selection student type equals Freshman.

Grab and drag saradap_styp_code to the filter area. The Filter for saradap_styp code dialog window opens. We are not sure how the data is
stored in this field so we are going to click on the Values button and select Fetch All Values from the Source. This will provide us with a list of Val-
ues in the source data. We want to pick F. Double Click F in the Data Values section so it appears in the Selection Values section then click OK.

Once again notice the change in the Interactive Design View window. Click the Slicers tab and select 500 in the Runt time box. Run your Report.

Click the IA icon and select save. Name the report yourname41 click OK. Click the IA icon again and select Exit. You should be back at your folder.
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Exercise 4.2

Using Masking in Filters

Create a new report using spriden_current_asu_v. Add spriden_last_name, spriden_first_name, and spriden_mi to the report.

Click and Drag spriden_last_name to the filters area. In the Filter for spriden_last_name dialog window. Select Like character mask . Type in
Smi% in the Add dialog and click the Add button to add it to the Selection Values area. Click OK.

Notice again that the Interactive design view changes to match your filter. Click the Slicers tab and select 500 in the Run Time box.
Run the Report.

Click on the IA button and select Save. Name your report yourname42 and click OK. Click the IA button again and select exit. You should be back
at your folder.
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Exercise 4.3

Compound Filters

Highlight and right click on yourname41 report in your folder and select copy. Right click on your folder and select paste. Right click on your-
name41 (copy 1) and select properties. Change the name to yourname43 and click OK. Right click on yourname43 and select open.

Add saradap_levl_code after saradap_term_code_entry in your report. Click on saradap_styp_code in the Interactive Design View window and
right click and select delete.

Select saradap_styp_code in the Filter area, right click and select delete.

The only filter you should have now is the saradap_term_code_entry equal to 201110.
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£l SARADAP_ADMT_CODE 4| m -
"—!i"e“ Across
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Grab and drag saradap_levl_code to the Filter area. Click Values, Fetch all Values from Source. Click G and G2 to add these values to the Selec-

tion Values. Click OK.

Highlight saradap_levl_code in the filters window. Right click, Select Open, then select Advanced Filter. Click the Insert After button, in the field
list select saradap_admt_code leave the equal to Click on <Value>, Leave the type as Constant, Click the Get Values button, click All, then select

EX from the list and add it to the Multiple Values window. Click OK.

Right Click on the OR between the 2 statements and Select Edit. Change the OR to AND. When completed Click OK.

Again Notice the Interactive Design View window changes to match your selections.

Run the Report.

Click the IA button and select Exit. You will be prompted to save changes. Select yes.

You should be back at your folder.

oY Create » fiitering condition

-{}' Mew Filter J Insert Before ! Insert After - Group
L | F -
+ \, WHERE SARADAP_TERM_CODE_ENTRY Equal to 20111...
= JF wHere
SARADAP_LEVL_CODE Equal to G or G2
OR
SARADAP_ADMT_CODE Equalto <Value> =

Ty Constant

Value:

! Get Values~

AM
AP
AT
8C
8T
EI
FA
GE -

m

HLSTHO ZOTTTO

424288 201110

0 -

>

Multiple Val... <&

EX

v ok

= I ey o
B3 }:r Create a filtering condition

v X

& cancel

0 J,}r MNew Filter J Insert Before '!InsertA&er - Group v
L [(F U -

% J WHERE SARADAP_TERM_CODE_ENTRY Equal to 20111...
= ¥ WHERE

SARADAP_LEVL_CODE Equal to G or G2
5
| ¥ tncertBefore Shift+UP

x Insert After  Shift+DOWN

= Group Ctrl+RIGHT
K Remove Ctrl+DEL
F° cut Chrl+X

1 Copy Clrl+C

o oK
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Exercise 4.4

Numeric Filters

Highlight your report named yourreport33 and right click and select copy. Select your folder and right click and select paste.
Right click on yourname33 (copy 1) and select properties. Change the name of the report to yourname44.
Right click on yourname44 and select Open. The report will open in InfoAssist.

Drag and drop shrtrce_credit_hours to the Filter area. Select Greater than or equal to from the drop down list. Type in 12.00 in the Add box,
then click the add button. Click OK.

Y Filter for SHRTRCE_CREDIT HOURS = |
v 0K “) Reset & cancel ¥ values ~ E Prompt =
Greater than or equal to -
Add:
Selection Valu... : . v
12.00
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Notice the change in the interactive Design View.
Right click on shrtrce_credit_hours greater than or equal to 12.00 in the filter section and select Open then select Advanced Filter.

The create a filtering condition dialog open. Highlight the statement Shrtrce_credit_hours Greater than or equal to 12.00. Click Insert After
button. You are prompted to pick a field, select shrtrce_credit_hours, Click Equal to and scroll down and select Less Than or equal to.

Next click <Value> , leave Constant as the type. Enter 60.00 in the Value box. And click OK.
Last but not least right click on the OR between the statements and select Edit, then Select AND. Click OK.

Run the Report. Click the IA button and Select Exit. You will be prompted to save your changes. Select Yes.

L ; errEate a filtering condition O x
. r Filter .
4}’ Mewr Filter ;’ Insert Before ! Insert After - Group -
B X [ O 0]« —
J SHRTRCE_CREDH_HDURS F.rn:i'a.;&.:ln_nhn.{:.l.l.:Lht E e T ] ST e
" ¥ simple Filter = JF where
- SHRTRCE_CREDIT_HOURS Greater than or equal to 12.00
/5 Delete ¥ or : .
SHRTRCE_CREDIT_HOURS Less than or equal to <Value> |w i 17.000
1. g QUE‘W | I Exclude | ‘ ‘ Ty... | Constant i
| | )
rrCreate a filtering condition jraltes
. . o
4}! Mew Filter J Insert Before l Insert After - Group v
— . B Get values~
X [ 0 -
= J WHERE
SHRTRCE_CREDIT_HOURS Greater than or equal to 12.00
OR —
SHRTRCE_CREDIT_HOURS Equal to | <Value> 2308
2309
Equal to £ 2393
Mot equal to [ 2520 .
Greater than <l "
Less than

m

Greater than or equal to

| Less than or equal to |

In literal list L
Mot in literal list

Missing

Mot missing

From - To i
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Exercise 5.1

Creating Prompts

Right click on yourname41 and select copy. Right click on your folder and select paste. Right click on yourname41 (Copy 1) and select properties.
Enter yourname51 in the Name dialog box and Click OK.

Right click on yourname51 and select Open. The report will open in InfoAssist. In the Filter window, right click on saradap_term_code_entry
equals 201110 and select Open, then select Advanced Filter.

You should see a window like the one below.

f JCreateaﬁltering condition 0 x
- -{',r Mew Filter J Insert Before .!Insert After - Group v

& | F
-

= JF WHeRre

£

i SARADAP TERM_CODE_ENTRY Equal to 201110
. + J WHERE SARADAP_STYF_CODE Equal to F
¢
¢

y -f’ 8] & Cancel
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Right click on the 201110 part of saradap_term_code_entry equals 201110 and select Edit. Change the type to Parameter. Change the descrip-

tion to Select Term.

Click the radio button for Static. Click the box for Select Multiple values at runtime,.

In the Value box enter the following 200940, 201110, 201120, 201130, 201140 you have to enter after each value you want to add.

Click OK. Run the report.

,'!Crc—atc—afiltering condition O x
{}’ Mew FEilter | .a’ Insert Before ! Insert After | <% Group v
K ! r 11_-.‘]
= J WHERE ST
SARADAFP _TERM_CODE_ENTRY Equal to  Multiselect Prompt (200940, 201110, 201120, ...} - ST
Y J WHERE SARADAP_STYP_CODE Equal to F T¥... Parameter -
Ma... SARADAFP _TERM_CODE_Er Descripti... Select Term
I Simple @ Static ") Dynamic
[¥] Select multiple values at runtime
Value: Multiple val.. & W €
© 200040
201110
¥ Get values~ 201120
201130
201140
SDAF_STYF_CUDE o
ADAP_ADMT_CODE 450498 2007
450499 2007
4350501 2007 v ok S cancel
5 450507 2007
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In the Filter window once again right click on saradap_term_code_entry equal to Multi Select Prompt, select open, then select Advanced Filter.
You should see a window like what is pictured below.

Right click on the Multiselect Prompt and select Edit.

Leave the type as parameter

Click the radio button next to dynamic.

_}; Create a filterin; condition - N 0 x
{_ -ﬂr New Filter | J Insert Before K Insert After | W Group ¥ Lingr !
" = ¥ wHere

SARADAP TERM_CODE _ENTRY Equal to Multiselect Prompt (200940, 201110, 201120, .....
J J WHERE SARADAFP_STYP_CODE Equalto F

I+

: v oK &) cancel
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Remove the check in the box next to Select Multiple values at runtime. Select SARADAP_TERM_CODE_ENTRY.

Then click OK until you are back at the design window.

Run the report now. Notice that you are only allowed to pick one term and the list of terms is all terms in the data.
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[#]

HCrrzatE a filtering condition

%’New Filter ‘ :lnsert Before

= J WHERE
SARADAP_TERM_CODE_ENTRY

| J WHERE SARADAF_STYP_CODE Equal to F

DRF_STYP_CUDE

ADAP_ADMT_CODE

O X
x Insert After ¥ Group w Ungroup
|
5T
Equal to  Multiselect Prompt (200940, 201110, 201120, ...} - ST
j 5 e Parameter -
Ma... SARADAF_TERM_CODE_Er Descripti... Select Term
) Simple ) Static @ Dynamic
Select multiple values at runtime
SARADAP
= 8- &
= @ sARADAP -
= 48 Dimensions (.
£l SARADAP_TERM_CODE_ENTRY
Fl SARADAF_LEVL _CODE
450498 2007 El SARADAP_APPL_DATE i
450499 2007 ¢ I :
A0 v ok cancel
450502 2007 .. s




Right click once again on saradap_term_code_entry equal to Dynamic prompt and select Open then select Advanced Filter.
Right click on Dynamic Prompt and select Edit.

Leave the type as Parameter. This time select the radio button next to simple.

Click Ok until you return to the design window. Run the report. Notice now you have to enter a term.

Close the report output, Click the IA icon and select Exit. It should prompt you to save, yes you want to save. You should be back at your folder

under the Class folder.

_erreate a filtering condition = 4
.{,lr Mewr Filter J Insert Before l Insert After & Group 2
X |7 0 0 s B
= JF wHERE ST
SARADAP_TERM_CODE_ENTRY Equal to  Multiselect Prompt (200940, 201110, 201120, ...) - .7
+ J WHERE SARADAP_STYP_CODE Equal to F . Parameter =

Ma... SARADAP TERM_CODE_EP Descripti... Select Term

@ Simple i () Static ) Dynamic

UAP_STYP_LUDE . 5
DAP_ADMT_CODE S 2004
450499 2007

450501 2007 v ok & cancel
450502 2007 .. .
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Exercise 6.1
Inner or Single JOIN

Right click on yourname31 in your folder and select Copy. Right click on your folder and select Paste. Right click on yourname31 (copy 1) and
select Properties. Change name to yourname61 and click OK. Right click on yourname61 and select Open. The report will open in InfoAssist.
Select spriden_change_ind in the Interactive Design View and right click, select Delete.

Click the DATA tab in the quick access toolbar. Click JOIN button. The Join dialog window is displayed.

B oata

| . Add New | 3 Edit ;: Remove J Filter | a View 5 Index Only
= @ SPRIDEN_CURRENT_ASU_V -
= @ pimensions E
i
£l SPRIDEN_LAST NAME ame -
E) SPRIDEN_FIRST_NAME : £ SPRIDEN_ID |
B SPRIDEN_MI © | & sromasTh|T
B SPRIDEN_CHANGE_IND . 5 £ SPRIDEN_FIRST_h
 CODTRCRL CRTTOY TRID | £ SPRIDEN_MI
¥ Fiter | ' [ SPRIDEN_CHANGE

£l SPRIDEN_ENTITY_
. B SPRIDEM_ACTIVIT .
I 4

’ SPRIDEN_CHANGE_IND Missing

ESum
SBw
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In the Join dialog window click Add New button and select SPRADDR_PS_ASU_V and click OK.

Scroll down until you find spriden_pidm and click and drag to the spraddr_ps_asu_v spraddr_pidm.

Notice the arrow drawn between the two tables.
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PEere A Errr o a

juin =
ﬂﬁ.dd Mew ‘ & Edit z Remove zr Filter ‘ 3ti‘l.nfim-.r —™ Inde
gspmc-m_c URRENT_ASU V j SPF ¥
Name - MName -
Fl SPRIDENM_SOUMDE Fl SPRADDR_REVIEW
Fl SPRIDEMN_NTYP_Ct Fl SPRADDR_REVIEW
Fl SPRIDEN_CREATE Fl SPRADDR_DATA_C
El SPRIDEN_CREATE_ Il SPRADDR_PIDM
Il SPRIDEM_DATA_O l Fl SPRADDR_SEQNO —
Il SPRIDEM_CREATE, T £l SPRADDR_DELTVEE -
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Double click the arrow between the 2 tables.

Change the Instances: Single

Change the Type: Inner

Notice the intersection of the two tables. That is a pictorial representation of a Single Inner or ONE to ONE relationship between the tables.
Click OK.

Click OK until you return to the Interactive design window.

PEAL A SR TR

BEditJoin = |

Description: Internal Name:
— SPRIDEM_CURRENT_ASU_V R — SPRADDR_PS_ASU_V
2 2 - v -
MName Title Mame Title
Instances:
El SPRIDEM_FIDM SPRID... El SPRADDR_FIDM SPRAD...
Single -
Type:

- Inner -

1 | m | 4 Fi 1] i b

! i:rFiIter v oK &Cancel
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Highlight spriden_mi in the interactive design view then scroll down in the data window until you find Spraddr_street_line_1, double click to get
that field after spriden_mi in the interactive design view.

Select spraddr_city, spraddr_stat_code, and spraddr_zip and double click to get in your report.

Your Interactive Design View should look like the picture below.

Run the report.

Save the report and exit back to your folder.

"™ Interactive Design View

= ; Data

iaooooDOD

SPRADDR_STR #
SPFRADDR_STR.
SPRADDR_STR.
SPRADDR_CITY—
5 PR}'-\I:)DR_S'I'F'('i
SPRADDR_ZIP
SPRADDR_CNT

CARANDD BEAT

_ ¥ riter

J SPRIDEN_CHANGE_IND Miss...

—@Qu&r‘f

3. sum
= % B
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SPRIDEN_ID

900000027
900000028
900000029
900000032
900000033
900000034
900001005
900001006
900001007
900001008
900001009
900001010
900001012

AAARRANAE

SPRIDEN_LAST_NAME

Kershner
Lampley
Kirkpatrick
Turner
Pridgen
Carzoli
Moll
Nunn
Karabinis
Orff
Pinders
Bickers
Fisher

L B R

SPRIDEN_FIRST_NAME

Amanda
Audra
Rickey
Etizabeth
Amy
Annemarie
Krista
Tasha
Nikeki

SPRIDEN_MI

Micole
Bevan
€.
Ausley
Michelle
Page
Beth
Noel
Virginia
Richard
Lynne
Ann
Olson

gt

SPRADDR_STREET_LINE1

1102 Forest Wood Drive
318 Belwood Drive
174 Hemlock Drive

5 Grace Avenue

2070 Vance Street
1684 Ashebark Court
5710 Cabe Ford Road
251 Piney Top Drive
1212 Old Bristol Road
8901 Otive Dairy Rd.
121 Cat Hole Road
520 Hickory Dirive
447 Poplar Hill Drive

AR Pt TS

SPRADDR_CITY

Matthews
Belmont
Boone
Asheville
Newtan
Marietta
Durham
Millers Creek
Boone

Apex
Claremont
Mountain City
Boone

o SRS R

SPRADDR_STAT_C

NC
NC
NC
NC
NC
GA
NC
NC
NC
NC
NH
TN
NC

KB



Exercise 6.2

Left outer JOIN

Right click on yourname31 in your folder and select Copy. Right click on your folder and select Paste. Right click on yourname31 (copy 1) and
select Properties. Change name to yourname62 and click OK. Right click on yourname62and select Open. The report will open in InfoAssist.

Select spriden_change_ind in the Interactive Design View and right click, select Delete. Select spriden_id in the Interactive Design view and right

click, select Delete.

Add a filter for Spriden_entity_ind equal to P.

— PR PR S — S S — S

erreate a filtering conditicn

]
"

E -{; MNew Filter J Insert Before lmsertﬂﬂ:er - Group v
K [ 10 -

- = ¥ wHERE |
SPRIDEN_CHANGE_IND Missing
> AND w

; SPRIDEM_ENTITY_IND Equalto P

P v’ oK © cancel

28



Click the DATA tab in the quick access toolbar. Click JOIN button. The Join dialog window is displayed.

Click Add New, Select SHRTRCE.

Scroll down until you find spriden_pidm and click and drag to the shrtrce shrtrce_pidm.

Notice the arrow drawn between the two tables. Double Click the Arrow between the two tables.

Change the Instances to Multiple if it is not already. Notice the graphic depicting a ONE to MANY relationship.
Change the Type to Left Outer.

Click OK. Click OK again to return to the Interactive Design View.

g yEdit Join O s
&Add New 3 Edit ;: Remave zr Filter E‘:View —# Ind
| Description: Internal Name:
_ SPRIDEN_CURRENT_ASU_V E— — SHRTRCE
| | SPRIDEN_CURRENT. &S G - B h a w B on A w
| Name = Hame = MName Title . Name Title
£l SPRIDEN_SOUNDE £l SHRTRCE_REPEAT £l SPRIDEN_FIDM ' SPRID... i i Fl SHRTRCE_FIDM SHRTR...
¥} SPRIDEN_NTYP_Ct £l SHRTRCE PIDM Multiple =
El SPRIDEN_CREATE. Fl SHRTRCE_TRIT_S Type:
B SPRIDEN_CREATE Bl SHRTRCE_TRAM_[ | [“Left Outer gy
£) SPRIDEN_DATA_O| _ £l SHRTRCE_SEQ_N( _ = =
L] SPR.U]EN_CREATE_; 7 Fl SHRTRCE_TRCR_S
) SPRIDEN_PDM - Fl SHRTRCE_CREDIT
< [l b < [ 3

:rFiIter v 0K &Cancel

SOTAO S
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Highlight spriden_mi in the Interactive Design View. Scroll down and find the following in the data window and add to your report after
spriden_mi. Shrtrce_sub_code, shrtrce_crse_numb, and shrtrce_crse_title.

Grab shrtrce_term_code_eff and drag to the Filter area. Create the filter shrtrce_term_code_eff equal to 201040.
Add a title to your report— Course List for Students for Term 201040
Run and Save your report.

Exit back to your folder.

Detail Summary
(Define) (Compute)
 Calculation Join Filter Data Source
3 pata ) Interactive Design View

El SHRTRCE_TERM_CODE_EFF =
£l SHRTRCE LEVL CODE SPRIDEN_LAST_NAME  SPRIDEN_FIRST_MNAME  SPRIDEN_MI  SHRTRCE_SUBJ_CODE SHRTRCE_CRSE_NUMB SHRTRCE_CRSE_TITLE

£} SHRTRCE_SUBJ_CODE

B e GuE e Byrd Jacob Andrew REL 1110 RELIGIONS OF THE WORLD
N E| Earp Daniel Reid ACC 2100 PRIN OF ACCOUNTING |
T 2110 PRIN OF ACCOUNTING Il
N ——— BIO 1101 BIOLOGY IN SOCIETY |
ROV 1102 BIOLOGY IN SOCIETY II
: BUS ELEC BUS ELECTIVE CREDIT
- ¥ Fiter COM 2101 PUBLIC SPEAKING
J SPRIDEN_CHANGE_IND Missing and SPR... ECO 2030 PRIN ECON-PRICE THEORY
J SHRTRCE_TERM_CODE_EFF Equal to 20... 2040 PRINC OF ECON - MACRO
2100 BUS & ECO STATISTICS |
B queny ELE CRED ELECTIVE CREDIT
i ENG 1000 EXPOSITORY WRITING
% sum 3 ELEC ENG ELECTIVE CREDIT
o By ‘ ‘ GEP MAT QUANTITATIVE LITERACY CRED
Fl CPRTNEM | AST MAME uic 470N AMECDI,T AR LNICTNADV
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Using DEFINE to create a nice formatted telephone number

Right click on yourname31 and select Copy. Right click on yourname folder and select paste. Right click on yourname31 (copy 1) and select prop-

erties. Type yourname71 in the name box and click OK.

Right click on yourname71 and select Open.

Remove Spriden_change_ind and Spriden_id from the report by right clicking and select Delete

Create a SINGLE INNER join to spraddr by clicking on the data tab and clicking the JOIN button. Click Add New button in the JOIN dialog and pick
spraddr from the list of tables available. Highlight spriden_pidm, click and drag to spraddr_pidm. Double click the arrow between the two tables

Exercise 7.1

and change instances to SINGLE and type to INNER . Click OK until you return to the Interactive Design view.

T loin
=

Q? Add Mew s Edit

f! Filter % View

é’é’b”r{b}bnh : x|

' Name

El SPRIDEN_SOUNDE
Fl SPRIDEN_NTYF_Ct
Fl SPRIDEN_CREATE,
Fl SPRIDEN_CREATE
£l SPRIDEN_DATA_O
4] SPRIDEN_CREATE_E
]l SPRIDEN_PIDM

+ :r}r b

m

Name =

] SPRADDR_CTRY_(
£l SPRADDR_HOUSE,
Il SPRADDR_STREET
El SPRADDR_FIDM

£} SPRADDR_SEQNO

F) SPRADDR_DELIVE! £
£l SPRADDR_CORRE( _ |

< [ 3

v OK

5) cancel




On the Data Tab Click the DEFINE Button. First we will get the phone number in one field by using concatenation.
Enter FIELD1 in the Field name box. Enter A10 in the Format Box.

Double click spraddr_phone_area click the | | symbol in the calculator or type it.

Double click spraddr_phone_number

Your define should look like the one below. Click OK.

| 77 Detsil Field (DEFINE) 0 x

!

Field  FIELD1 Format  A10 -|[Tall - E]l -| £
SPRADDR_CITY -
SPRADDR_STAT_CODE
SPRADDR_ZIP
SPRADDR_CNTY_CODE
SPRADDR_NATN_CODE
SPRADDR_PHONE_AREA
SPRADDR_PHONE_NUMBER
SPRADDR_PHONE_EXT
SPRADDR_ACTIVITY_DATE
SPRADDR_USER
SPRADDR_ASRC_CODE
SPRADDR_CARRIER_ROUTE
SPRADDR_GST_TAX_ID
SPRADDR_REVIEWED_IND
SPRADDR_REVIEWED_USER
SPRADDR_DATA_ORIGIN
SPRADDR_CTRY_CODE_PHONE ~

4 m b

J001.SPRADDR.SPRADDR_PHOMNE_AREA ||
JO01.5PRADDR.SPRADDR_PHOMNE_NUMBER |

m

THEN AND OR f 0

ELSE NOT == 0 g u

- S - - - N - T - - N N NN

\-/ Ok @ Cancel

T LLAr T B [AYRERIE ot
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Click the DEFINE button again. The Field name will be PHONE. The Format will be A14. Place your cursor in the expression box and click the
Functions button on the right corner of the define dialog. Expand the Character functions by clicking the plus sign and scroll to EDIT. Double click
EDIT and you will see it is added to the expression box.

Replace infield with FIELD1. Replace mask with (999) 999-9999.

Your PHONE field should look just like what is below. Click OK to return to the interactive design view.

7 Detail Field (DEFINE) Mo
Field  PHONE Format  Al4 B || & || E] | &l
EDIT ( FIELD1 , '(999) 999-9998' ) = |} Character -

) ARGLEN ( inlength , infield , outfie...
_j BITSON (bitnumber, string, cutfie...
_j BYTWAL ( character , outfield )

__:J CHKFMT ( numchar , string , 'ma...
J CTRAN { charlength , string , inde...
J CTRFLD { string , length , outfield )
__| EDIT ( infield , 'mask' ) |
__| GETTOK ( infield , inlength , toke...
11 = = = 4 5 6 _j LCWORD ( inlength , string , outfi...
_j UUST ( length , string , outfield )
_j LOCASE ( inlength , string , outfie...
THEN AND OR / 0 ) _;5 OVRLAY ( string , stringlength , =...
_j PARAG [ stringlength , string , del...

m

ELSE NOT == 0 ! U _j POSIT ( string , stringlength , sub...
_j REVERSE ( length , string , outfiel...
. | RIUST ( length , string , outfield ) b
v oK &) cancel =Tk "J- o = %
[ ISt AR ] EXTILTF v
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Scroll down in the DATA window until you find your FIELD1 and PHONE field you just created and add them to your report after spriden_mi.
Run the report. How does that look? Close the output window. Click the IA icon and select exit. Yes you want to save.

You should be back at your folder again.
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SPRIDEN_LAST_NAME SPRIDEN_FIRST_NAME SPRIDEN_MI FIELD1 PHONE
Abbott Paige Willow () -
8282623070 (828) 262-3070
8282645938 (828) 264-5938
Richard M. ()-
8282623055 (B28) 262-3055
8282640993 (828) 264-0993
Arsenault Jennifer Lynn () -
0000000000  (000) 000-0000
Beaulieu Elizabeth A. () -
8282627603  (828) 262-7603
8289631841  (828) 963-1841
Bickers Kimberly Ann ()-
0000000000  (000) 000-0000
Bordeaux Elizabeth Cone ()-
8282624089 (B28) 262-4089
8282650037 (828) 265-0037
Botelho Christopher Michael () -
Burns Colleen K. ()-
0000000000  (000) 000-0000
Cartaya-Marin Claudia P. ()-
8282622763 (B28) 262-2763
8282971090 (828) 297-1090



This time you are going to create a report from scratch. Right click in your folder and Select InfoAssist. Click build a Report from the splash

Exercise 7.2

Create a SUB GPA report for students using a COMPUTE

screen. Select ASU_STUDENT_COURSE from the open dialog window and click OK.

Add NAME, ID, COLLEGE_DESC to the report.

Create a DEFINE field called FULL_CRSE_NAME by going to the data tab and clicking the DEFINE button.

Field = FULL_CRSE_NAME Format = A20

Double click SUBJECT field to get it in the expression box, click or type || (double bar), add a left paren, add a single quote, space, single quote,

single bar (|), double click COURSE_NUMBER, add a right paren, click or type || (double bar), add a left paren, a single quote, a dash, a single

guote, a single bar (|), double click COURSE_SECTION_NUMBER, add right paren. Click OK

SUBJECT || (““ | COURSE_NUMBER) || (' | COURSE_SECTION_NUMBER)
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;ﬂ Detail Field (DEFINE)

Field FULL_CRSE_NAME Format A20

ASU_STUDENT_COURSE.ASU_STUDENT_COURSE.SUBIECT |] ("'l
ASU_STUDENT_COURSE.ASU_STUDENT_COURSE.COURSE_MUMBER ) || (™' |
ASU_STUDENT_COURSE.ASU_STUDENT _COURSE.COURSE_SECTION_NUMBER )|

| < = i 7 8 9
1 = = 4 5 &
IF = = * 1 2 3
THEN AND OR f ]
ELSE NOT t 0 " u
v oK & cancel

= @ ASU_STUDENT_COURSE

=/ 8 Dimensions

L4}

e OO DODODDDD DD

D

NAME

ACADEMIC_YEAR
ACADEMIC_YEAR_DESC
ACADEMIC_PERIOD
ACADEMIC_PERIOD_DESC
SUB_ACADEMIC_PERIOD
SUB_ACADEMIC_PERIOD_DESC
COURSE_IDENTIFICATION
SUBIECT

SUBJECT_DESC
COURSE_NUMBER
COURSE_SECTION_NUMBER
COURSE_VERSION
COURSE_REFERENCE_NUMBER
START_DATE

m



Add FULL_CRSE_NAME to the report after COLLEGE_DESC.

Add QUALITY_POINTS and CREDITS_FOR_GPA to the report after FULL_CRSE_NAME.

Drag CREDITS_FOR_GPA to the filter box and create a filter for CREIDTS_FOR_GPA not equal to O (zero).
Click on the slicers tab and set the preview to 50 and run time to 500.

Click on the Data Tab and click the COMPUTE button.

—l_]_ki (% & B | Yrn ]
Home Insert Format  Data Slicers Layout View  Field
V7! New Group st o 0 . . - .
Run Time 500 - Create Slicers
o lind=ta Provian
~ Options - Record Limit ' * Group 1 e
E ‘ Dot o Interactive Design View
El REGISTRATION_SEQUENC =
F) COURSE_BILLING_CREDIT! COLLEGE_DESC  FULL_CRSE_NAME QUALITY_POINTS CREDITS_FOR_GPA
B} CREDITS_ATTEMPTED
B CREDITS PASSED Allie, Jonathan C. 200227624 . ART 1011-107 6.00 3.00
r} CREDITS_FOR_GPA Alvarez, Valerie 5. 900226285 . C | 2800-110 12.00 3.00
Ayers, David E. 900224499 . COM 3305-103 11.10 3.00
3 ;:i::::f: 1&] Bailey, Tonya H. 900224387 . CMA 1100-111 7.40 2.00
oS X Benson, Robert S. 900373396 . HED 3500-101 12.00 3.00
= Bottoms, Richard T. 200228097 . P R 2020-105 6.00 3.00
E Y L Bowman, Brian R. 900227837 . FDM 3100-103 8.00 2.00
_J CREDITS_FOR_GPA Not equal to 0 Buchanan, Nathaniel 5. 900373109 . C |1 2800-110 12.00 3.00
Carpenter, Richard K. 200298486 . STT 3820-101 .00 3.00
| %} Query Carter, Mary K. 900373486 . UsS 1150-105 12.00 3.00
o Carver, Amy E. 900298495 . P E 3001-101 12.00 3.00
Bl QUALITY_POINTS = Church, Tonya D. 900301666 . PSY 2301-101 9.90 3.00
. Bl CREDITS_FOR_GPA Clayton, Jeremy M. 200229690 . R M 4110-101 9.00 3.00
= Sy = Clutz, Leslie P. 900300932 . H P 1105-107 8.00 2.00
Fl MaAME Mial~a  Aalke: L OARTITYTT A KOS 24NN 407 2 NN A NN
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The Field name = SUB_GPA leave the Format D12.2. Click in the expression box to get your cursor there.
Find and click QUALITY_POINTS to add it to the expression box.

Click the / button or type it. (divided by)

Find and click CREDITS_FOR_GPA to add it to the expression box.

Click OK. Notice the new computed field is added to the report as the last field. Run the report, close the output window. Save and exit to return
to your folder.

a Summary Field (COMPUTE) Mow
Field SUB_GPA Format D12.2 I_-:] - E| - T:l - ﬁ
ASU_STUDENT _COURSE.ASU_STUDENT_COURSE.QUALITY _POINTS | £l ASU BOX -

ASU_STUDENT_COURSE.ASU_STUDENT_COURSE.CREDITS_FOR_GPA |
B ASU_EMAIL

™\, FULL_CRSE_NAME
= @ Measures/Properties

Fl PERSON_UID
EXTENSIONS
REGISTRATION_SEQUENCE_NUMBER.
COURSE_BILLING_CREDITS
CREDITS_ATTEMFTED
CREDITS_PASSED
CREDITS_FOR_GPA
CREDITS_EARMED
QUALTTY _POINTS
COURSE_CREDITS
HOURS_ATTENDED
GRADE_VALUE
- & ey COURSE_ATTRIBUTES_COUNT ==

GRADE_CHAMGE_COUNT ™

L Y e b LR R R i i P B R e R

THEN AND OR i 0

ELSE NOT =+ 0 - u

m

OO OOBEBDBDDB D
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Exercise 8.1

EDIT

Create a new report called yourname81 using ASU_PERSON_SENSITIVE. Add FIRST_NAME to the report as a BY field. Now we are going to use
EDIT to make the TAX_ID show only the last four characters.

Go to the Data tab and click the DEFINE button. Name the field MASKED Format = A4
Click the function button and open the character functions and click EDIT to get the EDIT function in the expression window.

Replace infield with TAX_ID. Replace mask with the following— $55559999 Click OK.

7 Detail Field (DEFIMNE) O X
G B MASKED . Format A4 = -||& ~||E] | &
EDIT ( R £l LEGACY_DESC *
ASU_PERSOM_SENSITIVE.ASU_PERSOM_SENSITIVE.TAX_ID , '$55$£9959')
B PRIMARY_MEDICAL_COMDITION
Bl PRIMARY _MEDICAL_COMDITION_...
El PRIMARY _DISABILITY
B PRIMARY_DISABILITY _DESC
B PRIMARY_DISABILITY _SERVICE
El PRIM_DISABILITY _SERVICE_DESC
Bl PRIMARY_MEDICAL_EQUIPMENT
I = = ¥ 7 8 9
El PRIMARY_MEDICAL_EQUIPMENT ...
I = = = 4 5 6 B RELIGION | Segment: ASL_PERSOM_SI
El RELIGION_[D| Mame: PRIMARY _MEDIC
IF = ¥ 4 1 Z 3 Pl MMIGRATIC Alias: PRIMARY _MEDIC
Title: PRIMARY _MEDIC
A B / I.'.I z - i— Description: F'RIMAR"I"_MEDIE
&MASKED F 2 IAEEE'I.-' B
. ;L ormat:
ELSE NOT = 0 u = @ Measures/Propele—s
El PERSON_UID
B AGE
+ oK & cancel =
B RACE CATEGORY COUNT
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You now have a field with only the last 4 characters for the TAX_ID. Add MASKED to your report.

Go to the Slicers tab and set Preview to 50 and Runtime to 500. Run your report. Save the report as yourname81 and exit to return to your folder.

@ OB Hle « B9

Home (==t Format Data glicers  Layout View e i

>l O

(Define)  (Compute) .
‘Calculation Join Filter Data Source:
— Hpats ) Interactive Design View
B\ MASKED - :
= & Measures/Properties
El PERSOM_UID
B AGE Alice 2100
Fl RACE_CATEGORY COUN Amy 174
0 RACE_COUNT il Angell 2982
El MEDICAL INFDF‘.MA‘I’IDI\E' Ann 5885
- Bernadette 8768
» Betty e
- ¥ Fier Bannie 2041
Brian 3889
Cameron 9863
Casey 6558
Christopher 6635
Constance 2529
Curtis 9593
Debora 4571
Denny 4318
= %Query Donald 7320
Z 5um Eric 3527
= Floyd 2989
- @By J. 6857
St Jeffrev 3741
B O




Exercise 8.2

HDATE

Copy yourname81, rename yourname81 (Copy 1) to yourname82. Right click on yourname82 and select Open.
Add BIRTH_DATE to the report after MASKEDSS. Switch to the Data tab and Click on DEFINE button to create a new defined field.
Name the Field to BDAY set the FORMAT to MDYY

Click in the expression window to get your cursor there. Click on the Function Button, expand the Date and time folder and scroll to HDATE and
click to get it in the expression window.

Replace DTinfield with BIRTH_date from the field list. Change YYMD to MDYY to match the format of your new field. Click OK.

P E Dretail Field (DEFINE) B x

El - &

HDATE(ASU_PERSON_SENSITIVE.ASU_PERSON_SENSITIVE.BIRTH_DATE , 'MDYY") = @ ASU_PERSON_SENSTTIVE -

Field BDAY Format MDYY

T

(2

[3e]

= 4j ASU_PERSON_SENSITIVE
F) FERSON_UID

D

FULL_NAME_LFMI

LAST_NAME

FIRST_NAME

MIDDLE_NAME

TAX_ID

GOVERNMENT _ID

FOREIGN_TAX_ID

BIRTH_DATE

AGE

GENDER

GENDER_DESC

PRIM_ETHNICITY_CATEGORY

m

et

THEN AND OR ! ]

ELSE NOT e 0 " u

BE B DDEDBE D

PRIM_ETHNICITY CATEGORY_DESC d
I [ 3

" OK (S cancel il
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Add BDAY to the report after BIRTH_DAY. Check Slicer tab to be sure your Run time is set to 500. Run the report. Close the output window.

Exit and save. You should be back at your folder.

IA_. T a W (9 & S [ 9w
- Home Insert Format Data Slicers Layout View Field
e
z New Group T 5 -
2 Clear Slicers Drag fﬁk% h&m C
RunTime  sqg - Create Slicers
. hllwlniﬂ'ﬂrﬂuimfr .
Options Record Limit Group 1 &
3 pata 4\ Interactive Design View
B RELIGION -

El RELIGION_DESC
El IMMIGRATION_STATUS

FULL_NAME_LFMI MASKEDSS BIRTH_DATE BDAY

41

B IMMIGRATION STATUS_D Aldoescu, Alexandru J. 3331 1987/07/13 00:00:00 O7/13/1987

B, MASKEDSS Allen, Sandra J. 2616 1946/05/16 00:00:00 05/16/1946

&, BpAY Bl Babb, Tara M. 6335 1983/09/22 00:00:00 09/22/1983

@ @ Measuwes/Properties | Bartlett, Rebecca 5. 0567 1979/11/21 00:00:00 11/21/1979
e v Beebe, Karen L. 1489 1975/02/14 00:00:00 02/14/1975

= Bieganski, Marianne S. 9331 1986/10/01 00:00:00 10/01/1986

~ ' Fiter Bresell, Nancy C. 4716 1948/01/14 00:00:00 01/14/1948
I Brooks, Joseph B. 4595 1932/05/24 00:00:00 05/24/1932
Brown, Janet E. 2097 1967/05/06 00:00:00 05/06/1967

Brown, Sheila 9328 1965/07/05 00:00:00 07/05/1965

— Cacciola, Alex 7731 1984/12/10 00:00:00 12/10/1984
- =l Query Calhoun, Sarah M. 2035 1987/01/19 00:00:00 01/19/1987
™o Caudill, Dana E. 4380 1984/08/04 00:00:00 08/04/1984

o B Champigny, Heather 7517 1947/06/15 00:00:00 06/15/1947




Exercise 8.3

SUBSTR

Create a new report using TBRACCD. Create a SINGLE LEFT OUTER JOIN to SPRIDEN_CURRENT_ASU_V with TBRACCD_PIDM and SPRIDEN_PIDM.
Add SPRIDEN_LAST_NAME, SPRIDEN_FIRST_NAME to the report.

Right click on SUM in the query panel and select Print.

Drag TBRACCD_TERM_CODE, TBRACCD_DESC, TBRACCD_AMOUNT to the query panel under Print.

u Home Insert Format Data Slicers Layout View Field - TERACCD_AMOUNT
[ 2 Py " . .
Elnbtanionmiiin - N SR SIS
Prompt up Down Rank Limit Style Format Specific Visibility Links
Filter Sort
= ‘ s i . ) Interactive Design View
= {§ Measures/Properties -

£ TBRACCD_PIDM SPRIDEN_LAST_NAME  SPRIDEN_FIRST_NAME TBRACCD_TERM_CODE TBRACCD_DESC TBRACCD_AMOUNT

Bl TBRACCD_TRAN_NUMBER
EI TBRACCD_AMOUNT Andersen Aaron 200740 Prepayment- Tuition/Housing 200.00
F1 TBRACCD_BALANCE Anderson Elizabeth 200740 Prepayment- Tuition/Housing 200.00
£ TBRACCD_RECEFPT_NUMBLE] Andrews George 200740 Prepayment- Tuition/Housing 200.00
£) TBRACCD_TRAN_NUMBER, Behrens Christian 200740 Prepayment- Tuition/Housing 200.00
R - Bowman Daniel 200740 Prepayment- Tuition/Housing 200.00
= Brooks Gena 200740 Prepayment- Tuition/Housing 200.00
M r (7 e Chang Quoc 200740 Prepayment- Tuition/Housing 200.00
r Cirulis Andrew 201310 Textbooks Not Returned 13.61
Conard Casey 200740 Prepayment- Tuition/Housing 200.00
Deal Amanda 200740 Prepayment- Tuition/Housing 200.00
_E Query Dixon Adam 201310 Textbooks Not Returned 16.81
Il - >»> hN] Elliott Thomas 200740 Prepayment- Tuition/Housing 200.00
= & Frint Forrester Amy 201310 Textbooks Mot Returned 161.19
B TBRACCD_TERM_CODE Griffin Jonathan 200740 Prepayment- Tuition/Housing 200.00
B TBRACCD_DESC Grzesik Sarah 200740 Prepayment- Tuition/Housing 200.00
£l TBRACCD_AMOUNT Guernier Jeffrey 200740 Prepayment- Tuition/Housing 200.00
= % By Haney Joseph 200740 Prepayment- Tuition/Housing 200.00
B SPRIDEN_LAST_NAME Harriger Lane 200740 Prepayment- Tuition/Housing 200.00
B SPRIDEN_FIRST_NAME Harris Holly 200740 Prepayment- Tuition/Housing 200.00
g Acrass T | Kathrun 200740 2 Prenavment- Tidtinn/Haousing 200 NN
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Drag TBRACCD_DETAIL_CODE into the filter window and create the following— TBRACCD_DETAIL_CODE equal to 9925.

Drag TBRACCD_DESC into the filter windows and create the following—TBRACCD_DESC Like Character Mask EFOD%

| Home InEErE Format Data Slicers Layout View  Field
\— ¥ oclude - A Z i e Page Break | Sub Head K ) A - ﬂ
Wik B wiiomikion. - e i wa ma
Filter x’ el Prampt g GO Rark (it i L Style Format Specific Visibility Links
2l Siiltnrsl L i-- armmnnt
Fiter Sort T
B ‘ Data @ Interactive Design View
£ TBRACCD_USER »
El TBRACCD_ENTRY_DATE [=1 SPRIDEN_LAST_MNAME SPRIDEN_FIRST_NAME TBRACCD_TERM_CODE TBRACCD_DESC
B TBRACCD_EFFECTIVE DATE
B TBRACCD_BILL_DATE Abee Sam 200730 EFOD-SPACE GRANT 800.00
£ TBRACCD_DUE DATE Aguero Erica 200740 EFOD-GOLDEN LEAF 1500.00
£ TBRACCD DESC Avery Felicia 200740 EFOD-GOLDEN LEAF 1500.00
£ TBRACCD_ CROSSREF DETAL C( Beckner James 200740 EFOD-MCSSM 1111.00
i et v Biderman Rachel 200740 EFOD-GOLDEN LEAF 1500.00
= Bost Alisha 200740 EFOD-NC55M 1111.00
B ¥ rier Bouchard Matthew 200740 EFOD-Americorps 1000.00
JF TERACCD_DETAIL_CODE Equal to 9925 Byrd Ashley 200740 EFOD-GOLDEN LEAF 1500.00
F TERACCD_DESC Like character mask EFOD% Caldwell Sabrina 200740 EFOD-GOLDEN LEAF 1500.00
Cooper Matthew 200740 EFOD-Americorps 1000.00
5 Ej Query Cresawn Charles 200740 EFOD-GOLDEN LEAF 1500.00
- DUE Funds On Deposit 200740 EFOD-PTSL -239750.00
= gPrint 200740 EFOD-GOLDEN LEAF -30000.00
£l TBRACCD_TERM_CODE 200720 EFOD -465.13
Bl TBRACCD_DESC 200720 EFOD -1500.00
El TBRACCD_AMOUNT Flora Christopher 200730 EFOD-SPACE GRANT 800.00
= % By Harrold Kimberly 200740 EFOD-GOLDEN LEAF 1500.00
£l SPRIDEN_LAST_NAME Hatcher Heidi 200740 EFOD-MCS55M 1111.00
£l SPRIDEN_FIRST_MNAME Hayes Daniel 200740 EFOD-GOLDEN LEAF 1500.00
=5 Across Houo Sandi 200740 FEON-G:OI NEN | FAF 1500 00

1
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Create DEFINE Field called AWARD_CODE. Field—AWARD_CODE Format A17 Click to get your cursor in the expression box, click the Functions
button and expand Character and scroll down to SUBSTR and click to get the statement in the expression box.

Replace stringlength with 30, Replace String with TBRACCD_DESC, replace Start with 6, replace End with 17, replace sublength with 17, and re-

place outfield with AWARD CODE.

This is what your statement should look like.

SUBSTR ( 30, TBRACCD.TBRACCD.TBRACCD_DESC , 6,17, 17, AWARD_CODE )

E Detail Field (DEFIME)

Field \WARD_CODH

SUBSTR ( 30 , TBRACCD.TBRACCD.TBRACCD_DESC , 6,17, 17 , AWARD_CODE )

(F
I
i

THEMN AND OR i

ELSE MOT ==

Format

0

AlT

-/ oK & Cancel
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s oo oo oooocono B

Al

C

S - |[&] <|[E] ~| &

TBRACCD_ENTRY_DATE =i
TBRACCD_EFFECTIVE_DATE i
TBRACCD_BILL_DATE | |
TBRACCD_DUE_DATE |
TBRACCD_DESC |
TBRACCD_CROSSREF_DETAIL_CODE
TBRACCD_SRCE_CODE
TBRACCD_ACCT_FEED_IND
TBRACCD_ACTIVITY_DATE
TBRACCD_CSHR_END_DATE
TBRACCD_CRN
TBRACCD_CROSSREF_SRCE_CODE
TBRACCD_LOC_MDT
TBRACCD_DOCUMENT_NUMBER
TBRACCD_TRANS_DATE
TBRACCD_PAYMENT _ID
TBRACCD_INVOICE_NUMBER
TBRACCD_STATEMENT_DATE 2| |

m



Add AWARD _CODE between TBRACCD_DESC and TBRACCD_AMOUNT in your report. Click the IA icon and save your report as yourname83.

Run the report. Close the output and exit until you are back at your folder.

"t_ru: % ¢ S| rn |
¥ Home  mnsert

iSETL Format  Data  Slicers  Layout  View  Field
'. ‘: E | A Z ) NS e | Page Braal Sub-Head \5" T_.P i " -
Filiz Ll FromL U ey FAn it o - ~ style Format  Spedfic  Visibility Links
Filter sort Break
_ et ) Interactive Design View
£l SPRIDEN_DATA_ORIGIN -

£l SPRIDEN_CREATE FDMN_CODE
B3\ AWARD_CODE

= @ Measures/Properties
El TBRACCD_PIDM
B TBRACCD_TRAN_NUMBER £
El TBRACCD_AMOUNT

Ml TnnaAcom NALARICT

- "'Fiﬁer

J¥ TBRACCD_DETAIL_CODE Equal to 9925
JF TBRACCD DESC Like character mask EFOD%

= féj Query

= & Print
£ TBRACCD_TERM_CODE
£ TBRACCD_DESC
B, AWARD_CODE
£l TBRACCD_AMOUNT
= Eey

El SPRIMFM | AST MAMF

| »

m
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SPRIDEN_LAST_NAME

Abee
Aguero
Avery
Beckner
Biderman
Bost
Bouchard
Byrd
Caldwell
Cooper
Cresawn
DUE Funds On Deposit

Flora
Harrold
Hatcher

Hawves

SPRIDEN_FIRST_NAME

Sam
Erica
Felicia
James
Rachel
Alisha
Matthew
Ashley
Sabrina
Matthew
Charles

Christopher
Kimberly
Heidi

Naniel

200730
200740
200740
200740
200740
200740
200740
200740
200740
200740
200740
200740
200740
200720
200720
200730
200740
200740
nn740

TBRACCD_TERM_CODE

TBRACCD_DESC

EFOD-SPACE GRANT
EFOD-GOLDEN LEAF
EFOD-GOLDEN LEAF
EFOD-MNCSSM
EFOD-GOLDEN LEAF
EFOD-NCS5M
EFOD-Americorps
EFOD-GOLDEN LEAF
EFOD-GOLDEN LEAF
EFOD-Americorps
EFOD-GOLDEN LEAF
EFOD-PTSL
EFOD-GOLDEN LEAF
EFOD

EFOD

EFOD-SPACE GRANT
EFOD-GOLDEN LEAF
EFOD-MNCSSM
FFON-GOI NFN | FAF

SPACE GRANT
GOLDEN LEAF
GOLDEN LEAF
NCSSM
GOLDEN LEAF
MCSSM
Americorps
GOLDEN LEAF
GOLDEN LEAF
Americorps
GOLDEN LEAF
PTSL

GOLDEN LEAF

SPACE GRANT
GOLDEN LEAF
MCS5M

GO NFN | FAF

AWARD_CODE TBRACCD_AMOUNT

800.00
1500.00
1500.00
1111.00
1500.00
1111.00
1000.00
1500.00
1500.00
1000.00
1500.00

-239750.00
-30000.00
-465.13
-1500.00

800.00
1500.00
1111.00
1500 00



Exercise 8.4

HGETC

Right Click on yourname41 and select Copy. Right click on yourfolder and select paster. Right click on yourname41 (Copy 1) and select Properties.
Change the name to yourname84 and click OK. Open yourname84. Add saradap_appl_date after saradap_admt_code to the report.

Remove the saradap_term_code_entry equal to 201110 by right clicking on the field in the filter box and selecting Delete.

Create a new defined field by clicking on the Data tab and selecting define.

Name the new field NOW click the Format button to pick a format. Notice the field type is Date-time. Expand Year First in the Date Format box
and click YYMD. In the time Format box click Hour...Second. Leave the Separator /. Notice the sample format in the sample window. Also notice
the format below the separator. Click OK. You are returned to your define field NOW. Click in the expression box and select the function

button.

* 55 Field Format Options for (NOW) -
Field type: — Display options
Alphanumeric
Floating point Time Only
Integer
Decimal Date Format: Time Format:
Packed =l Year First “ Hour
Date
Date-Time ¥ Hour:Minute
¥y g| Hour.. Second
Sample: ¥M Hour. .. Milisecond
2013/09/09 10:14: 15 ¥¥M Howr .. .Microsecond
YMD
YYMD L
{ 1 3
Separator: - Ise AM/PM
HYYMDS

46 I . OK | ¥ Reset & cancel



Expand Date and time, then scroll down and click HGETC.
Replace outlength with 8. Replace DTformat with NOW

Click OK.

Add NOW to the report after saradap_appl_date. Notice both fields are the same format.
Click on the Slicers tab and make sure Runtime is set to 500. Run the report. Close the report output exit and save your report.

You should be back at your folder.

.
7 Detail Field (DEFIME) Tl | 7 Detail Field (DEFINE) B x
Field  NOW Format |HYYMDS B o+ & = El v || § red TR | Format | HYYMDS =@ -[@m -8 -
[ oTOMY ( days , outfield ) HGETC(8, NOW/) £} SARADAP_INTV_CODE -
L] DTDYM (days , outfield ) ; £ SARADAP_FEE_IND
_J DTMDY ( days , outfield ) a El SARADAP_FEE_DATE
[ oTMYD  days , outfield ) £l SARADAP_ACTIVITY_DATE
J DTYDM ( days , outfield ) £l SARADAP_RATE_CODE
L_] DTYMD ( days , outfield ) Fl SARADAP_EGOL_CODE
[] GREGDT (infield , outhield ) £1 SARADAP_EDLV_CODE
;j HADD(DTinfield, 'companent’, incremen. .. El SARADAP_MAJR_CODE_COMC_1
! % % 'k z s : L) HONVRT (DTinfield, ‘(DTformat)' outie... I £ 2 i ? s = £) SARADAP_DEPT_CODE
il < 5 = 4 5 5 [ HDATE(DTinfield, 'Y¥YMD') 1 z Z = 4 5 s £l SARADAP_SBGI_CODE
_J HDIFF (DTfield1, OTfield2, 'component... - £l SARADAP_RECR_CODE
B = s = i = E [ ] HOTTM(DTinfield, outiength, 'DTformat) | | = = ! £ z £ £l SARADAP_RTYP_CODE
THEN AND OR / 0 ; L:] HGETC (outlength, TTformat?) | THEN AND on / 0 . £l SARADAP_DEPT_CODE_2
L:] HINPUT (inlength, infield, outlength, 'D... Fl SARADAP_MAJR_CODE_CONC_2
ELSE NOT = 0 . u [ ] HMIDNT(DTinfield, length, ‘DTformat’) ELSE NaT = 0 ) u Tl SARADAP_PROGRAM_1
;j HMNAME(DTinfield, 'component’, ‘outfiel. .. El SARADAP TERM_CODE_CTLG_1
= L] HPART(DTinfield, ‘component’, 'outfield. .. = £l SARADAP_MAJR_CODE_1 2
© cancel [ ] HSETPT{DTinfield, ‘component’, infield, ... o || S £l SARADAP DEPT CODE 1 2 e
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Exercise 9.1
Excel Outputs

Create a new report using ASU_ACADEMIC_OUTCOME. Add College_desc to the report. Drag and drop person_uid under SUM in the query win-
dow. Right click on SUM and change it to Count.

Drag graduated_ind to the filter area and create a filter graduated_ind equal to Y
Drag Academic_period_graduation to the filters and create a filter academic_period_graduation equal to 201210.

Click on the Format tab and select Excel 2000. Run the report. Click the down arrow next to excel and pick a different excel format and run the
report. Save the report as yourname91 and exit.

E W e« [E9rn

Format Data  Slicers  Layout  View  Field

——7 e
lul} Chart | . &
El Report Table Features
Output Types ' Destination
1 3 Data %mteracﬁ\re Design WView

£l SECOND_MAJOR_CONC_3_DESC =
B FIRST_MINCR PERSON_UID
B} FIRST_MINOR_DESC COLLEGE DESC COUNT
£l SECOND_MINOR.

i

B SECOND_MINOR_DESC

B ACADEMIC_YEAR_GRADUATION

£l ACADEMIC_YEAR_GRADUATION_DE!
El ACADEMIC PERIOD GRADUATION

— ¥ Fiter

'\, GRADUATED_IMD Equal to ¥
J ACADEMIC_PERIOD_GRADUATION Equal to 201...

H 'EEIQUEW

= X Count

El PERSOM_LID
= Eey

Bl COLLEGE_DESC

% Across

48

College of Arts & Sciences

College of Business

College of Education

College of Fine & Applied Arts
College of Health Sciences
Graduate Schoaol

University College

9
2
5
12
[
13
1



Exercise 9.2

Styling, Heading and Footing

Copy yourname72 and rename yourname?72 (Copy 1) to yourname92. Open yourname92. Remove sub_gpa, quality _points, and credits_for_gpa

from the report.

Move Full_crse_name under SUM in the Query area and right click on SUM and select Print.

Drag College_desc to the first position after BY in the query area.

Delete credits_for_gpa from the filter area.

Drag Academic_period to the filter area and create a simple parameter Academic_period equal to Prompt.

Change the sort on College_desc by right click on college_desc and select sort, then click sort descending.

dJE He e @2k
(ES®  Home =t Format Data Sicers Layout View Field - COLLEGE DESC
Vilisn R abon 25 it -~ Clc Sty - [ e Seae
Ny MR A : 0 Bltneesk  sibFooter ooy === g =] Tite Style
Filter Prompt Up Down Rank Limit @Suhtm:ﬂ 5& S S = D .ElDETE 4 Title $ w0 o
Filter Sort Break Style ; Format —
o 3 Data ‘gﬁ Interactive Design View
= @ ASU_STUDENT_COURSE =
= 4§ Dimensions il § couiece pesc NAME I
oI
£ NAME University College Johnson, Laurie A, 900451835 UCO 1200-157
£] ACADEMIC_YEAR Schoaol of Music Eaton, Travis R. 200474919 MUS 2011-107
El ACADEMIC_YEAR_DESC Tate, Cynthia E. 300232082 MUS 5061-101
£l ACADEMIC_PERIOD College of Health Sciences Boyd, Natalie M. 00426868 H P 3200-101
Fl ACADEMIC PERIOD DESC o) Hopkins, Bethany L. 00473429 NUT 3205-101
- Schaffer, Anna E. 200392291 NUR 3102-100
[l r = College of Fine & Applied Arts | Allen, Kenneth D. 900382651 IND 1001-101
-\’ ACADEMIC_PERIOD Equal to Prompt Robson, Tony 300404418 P E 1071-171
College of Education Jackson, Dvlan B. 900501887 LSA 5030-377
McAdam, Holly M. 900396617  CD3364-101
College of Business Allen, Justin G. 900399257 CIS 2025-102
— Chiriboga, Fernando A. 300435942 ECO 2030-105
L F%I Query Clanton, Julian C. 00241301 MKT 3220-101
= & Print Furr, Stephen P. 300447768 POM 3650-103
&FULL_CRSE_NAME Henderson, Ryan A. 300417753 MET 3050-350
=] %By Meadows, Scott T. 900395940  ACC2110-110
F COLLEGE DESC Morgan, Ellen E. 300430846  CIS 2050-101
£l NAME Nichalson, Robert C. 300415831 ACC 3200-101
oo Morman, Lori M. 900454583  MKT 3260-102
%Across Rutten, Ryan M. 300445936 MKT 3060-101
College of Arts & Sciences Ashby, Laura J. 900394599 ANT 2215-101
Beveridee, Andrew R. 900497465 PHL 2015-105
Canra. Adam T. SON42T167 PSY 1200-114
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Click on College_desc in the interactive design view area. Notice the tab FILED—COLLEGE_DESC is highlighted.
We want to have each College on a separate page. Click the Page Break button.

Click the Home tab. Click the down arrow next to Header & Footer button and select Page Header.

Type Courses For a Person By College.

Change the font size to 14. Click OK. Notice the change in the interactive Design View.

Since you have a page break on each college you will now have a title on each page.

We want to change the FONT for the whole report.

DE Hie ¢ [E 3

Home  f.=ri  Format Data Slicers layout View  Field - COLLEGE DESC

® Jupeiilamt, ST Bl Bl B o A
HTML = Repart Query  Interactive | Document Records: 5 = Theme  Style
e e e
— Fpata W) Interactive Design View
= @ ASU_STUDENT_COURSE -
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Click on the HOME tab again. Click the Style Button. Change the Font to Times New Roman. Change the Font Size to 12.

Click Bold button to turn off Bold. Click OK.

@ Report Style r
TIMES MEW ROMAN - 12 -
BsUu|EEE| B@E|2
— Preview

TIMES NEW ROMAN 12

a4 e

Wllo's O cancel 2 apply

Click the Header & Footer button again. This time select Page Footer. Remove the Enter text here from the text window.

Click the Preformatted text button, scroll down to Date and Select the Date with the month full name. Click OK.

Run and save your report. Exit to get back to your folder. Since we have the output set to just 500 records you probably won’t see a different

College per page.
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Exercise 9.3

Rank, Line Breaks, Pop-up Titles

Create a new report using ASU_ACADEMIC_STUDY_CURRENT.

Add College_desc to the report as a BY field. Add Person_uid to the report as a sum field, right click on

Person_uid and scroll to More, select Aggregation Functions then select Count Distinct.
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Right click on College_desc and select Change Title—change the title to College.
Right click on Count Distinct PERSON_UID and select Change Title—Change the title to Number of Students Enrolled.

Click the Format tab and click the Title Popup button.
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Drag Academic_period to the Filter area and create a simple prompt. ACADEMIC_PERIOD equal to Prompt
Drag enrolled_ind to the Filter area and create ENROLLED_IND equal toY

Highlight College in the report, Click on Tab Field COLLEGE_DESC and click the Line Break button.
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Next we will RANK the enrolled by college. Right Click on College in the Interactive Design View window.
Select Sort, then Rank, then click On.
You will notice that RANK is placed in the report before College.

Save the report as yourname93. Run the Report. Close the output Window. Exit back to your folder.

M Interactive Design View Rﬂ Interactive Design View

Number of Students Enrolled

RANK College Number of Students Enrolled

College of Fine & Applied Arts 1
Graduate School 1 1 College of Arts & Sciences 103
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Exercise 9.4

Table of Contents, freezing columns, page on demand
Make a copy of yourname93 and name it yourname94. Open yourname94. Remove the RANK column from the report. Add Department_desc
after College as a By field. Change the Title to Department

Click the Format Tab and select the Table of Contents Button. Run the report. A table of contents icon is displayed in the top-left corner of the
report output. Double click the icon to display the Table of Contents pop-up menu. Click on a value in the Table of Contents. You can move tthe-
Table of Contents by clicking on the title bar then double clicking in the white space in the report. Close the report output.
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Back at the interactive design view in InfoAssist click the Format tab and click the Freeze Button.

Run the report again and notice the scroll bar available in the report .. Scroll and you will see the frozen column headings.

Close the output and return to the Interactive Design View.
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Back at the Interactive Design View in InfoAssist. Click the Format Tab and Select Pages on Demand.
Run your report again. Notice the bottom of the output window. Explore the options available with Pages on Demand. Close the output.

Save the report and exit.
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Exercise 10.1

Create an INFO MINI Application

Copy yourname72 and paste. Name yourname72 (copy 1) to yourname101.

Open yournamel0l. Remove Quality points, Credits_for_gpa, and Sub_gpa from the report. Move college_desc to the top of the BY subgroup
in the query area. Grab and move full_crse_name and drop it under Sum in the query area. Right click on Sum and change it to Print.

Click the Format Tab . Select the down arrow next to InfoMini and Click on Slicer Tab to get a check next to it, click on Data Tab to get a check

next to it , click on Home tab to get a check next to it. Click Resources/Field to get a check next to it.
Remove Credits_for_gpa not equal to 0 from the filter area. Drag Academic_period to the filter area and create the filter
Academic_period equal to Prompt

Go to the Slicers tab and select 500 for Run Time. Run the report.
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After the report finishes running notice what is available to the user. Click on the Edit tab. Now the user can add more fields, change the filters,

Remove fields. Check each available tab .
Close the output.

Save and Exit your report.
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Exercise 11.1

Build a Compound Report from an Existing Report.

Copy yourname72 and name the copy yournamelll. Open yournamelll. Change to Document on the Home tab. Remove Quality_points,

Credits_for_gpa, Full_crse_name, name and Sub_gpa from the report. College_desc should be the only field in the BY subgroup in the query

area. Grab and move Id to the sum area in query. Right click on id and select more, aggregation functions, and select Count Distinct.

Remove Credits_for_gpa not equal to O from the filters. Drag Academic_period to Filter and create the filter academic_period equal to 201230.

Move and size the report area to resemble what is below by grabbing the lines around the report and sizing and moving.
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Click the insert tab and click image. Select asubirdf.gif. Place the image above the report in the document. Size it by grabbing the lines around
it and dragging.
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Next we are going to insert a graph of the report we are displaying. Click on the insert tab and click Chart. A chart is inserted in the document.

You need to move it below the report. We are going to build the chart just like the report.

Drag college to the X Axis. Drag ID to Measure(Sum). Notice ID should change to CNT.ID. Drag Academic_period to Filter area and create Aca-
demic_period equal to 201230.

Set run Time to 500 on the slicers tab and run the report. Exit and save your changes .

You should be back at your folder.
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Exercise 12.1

Create a Chart in InfoAssist

Open InfoAssist. Select Build a Chart from the Splash Screen. Select spraddr_ps_asu_v. This will be just a simple chart.
Drag Spraddr_pidm to Measure(Sum) in the query area. Right click on Spraddr_pidm, select more, aggregation functions, select count.
Drag Spraddr_stat_code to X Axis in the query area.

Notice the preview is a bar chart.
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Click on the Format tab and go through the different charts available.

Change the title for CNT.SPRADDR_PIDM by right clicking on the field in the query area and selecting Change Title— Student Count.
Change the title for SPRADDR_STAT_ CODE by right clicking on the field in the query area and selecting Change Title—Student State .
Go to the Format tab and click the down arrow next to Grid Lines Button, Click 01 Major Gridlines to remove the Check mark.

Save the report. Run the report.
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